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Oracle Insurance Insbridge Rating and Underwriting
Installation and Upgrade Guide

Preface

Welcome to the Oracle Insurance Insbridge Rating and Underwriting Installation and Upgrade Guide.
The Insbridge Rating and Underwriting (IBRU) System is a browser-based, multiplatform
insurance rating and underwriting technology solution that provides integrated management for
every aspect of the rate definition and modification process.

The Insbridge Rating and Underwriting system is a web-based application with a database

backend that can be configured to utilize many different and complex configurations. This
document is meant to help with the installation of the Insbridge Rating and Underwriting System.

Audience

This guide is intended for system administrators, installers, database administrators and others
tasked with installing and configuring the IBRU system and associated databases.

SoftRater Node Installation

There are various methods used to deploy IBRU. It is recommended that at least two
environments be setup, one for development and testing and one for production. A preferred
setup is to have three environments, one for development, one for testing and one for production.

Each environment can have its own configuration and database structure. For example, it is
required that you have RateManager and IBFA on the same Windows machine in development.
However, when you move in to production you may want have IBFA on a separate machine with
an Oracle database.

To allow for packages to be moved from environment to environment, it is necessary to have a
SoftRater Node install. A SoftRater Node installation is required when you have IBFA and
RateManager on separate machines and you want to load packages from one environment to
another. The SoftRater node is installed on the receiving IBFA.

If performing a SoftRater node install, the following document also can be used.

Steps that don’t need to be performed for a SoftRater node installation are marked as not
required and colored red.
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E-Delivery

The Insbridge Rating and Underwriting (IBRU) System is available as a download from the Oracle
E-Delivery system. Downloaded files are zipped. Prior to installation, please make sure the
source machine(s) where IBRU will be loaded has an unzip utility.

An unzip utility for most platforms is available on the E-Delivery download page.

Documentation from E-Delivery is in PDF format. Prior to installation, please make sure the
source machine(s) where IBRU documentation will be loaded has a PDF reader.

Files are downloaded with part numbers as file names. Please make note of the part numbers
you have downloaded and the corresponding file name. You may be asked to provide the part
numbers or the filename if you contact Oracle Insurance Support.

The installation downloads you can select are:
Insbridge IBRU Install — This is required for all installations

SoftRater for WebSphere — This is required if you are using WebSphere
SoftRater for WebLogic — This is required if you are using WebLogic

guides and user guides are located here.

SoftRater for JBoss — This is required if you are using JBoss
Documentation — It is recommended that you download the documentation. Installation

SoftRater downloads are not required if you are running in Windows only.

Manual History

New editions incorporate any updates issued since the previous edition.

Edition Publication Prod_uct Publication Date Comment
Number Version
~1¥ Edition P01-701-01 03/28/2005 Updated for new layout /

Windows 2003

2" Editon ~ P01-701-02 04/14/2005 New layout, updated
ASPNET user permissions
req

3" Editon  P01-701-03 V3.6 03/14/2006 Update

4" Editon  P01-701-04 V3.7 09/28/2006 Update

5" Editon ~ P01-701-05 V3.8 July 2007 Update

6" Editon  P01-701-06 Vv 3.8.3 October 2007 Update

7" Editon  P01-701-07 V 3.8.5 November 2007  Update

8" Editon = P01-701-08 VvV 3.8.7 January 2008 Update

9" Editon  P01-701-09  V 3.8.8 March 2008 Update

10" Edition  P01-701-10 V3.9 May 2008 Update

11" Editon  P01-701-11  V 3.10 September 2008  Update

12" Edition  P01-701-12  V 3.11 December 2008  Update

13" Editon  P01-701-13  V 3.12 July 2009 Update
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Checklist of Requirements and Procedures

The following checklist can be used to help in installing and configuring a SoftRater node.

a Check Web Server for needed dependencies
Q IS Installed
a MSMQ
O Microsoft .NET Framework version 2.0 or 3.5

Q Check Database Server for needed requirements
Q Proper Network Connection to Database Server
0 Mixed Mode Authentication
O Not using NT Fibers
0 Collation and Sort Order Supported

Q Create Insbridge Local User Account
o

Insbridge User Account Name:
O Insbridge User Account Password:

Q Install Insbridge Framework

a Set full permissions for the Insbridge user Registry Access

Q Set full permissions for the Insbridge user Temp Folder for MSMQ
Set full permissions for the Insbridge user to the Insbridge folder

O

Q Attach IBSR and IB_CLIENT database
Insbridge IBSR Database Name:
Insbridge IB_CLIENT Database Name:
Databases Owner User Account:
Databases Owner User Password:
Assign Database User Account as db_owner to IBSR database

OO00DoD0o

Q Configure IBFA

Add Subscriber ID

Add Database Connection for controller pointing to the IB_CLIENT database
Add Database Connection for security pointing to the IB_CLIENT database
Add SoftRater Environments for loading of SRPs and rating

000 o

a Install OBl Publisher
O Start Message Service

a Import the registry key from RateManager server
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The following checklist can be used to help in installing and configuring the IBRU system.

a Check Web Server for needed dependencies
IIS Installed

MSMQ

Microsoft .NET Framework version 2.0 or 3.5
JRE

0O 00D

Q Check Database Server for needed requirements
Proper Network Connection to Database Server
Mixed Mode Authentication

Not using NT Fibers

Collation and Sort Order Supported

000D

Q Create Insbridge Local User Account
Insbridge User Account Name:
O Insbridge User Account Password:

O

Q Install the IBRU System

a Set full permissions for the Insbridge user Registry Access

Q Set full permissions for the Insbridge user Temp Folder for MSMQ
Set full permissions for the Insbridge user to the Insbridge folder

O

Q Attach IBRM and IB_CLIENT database, and IBSR database
Insbridge IBRM Database Name:
Insbridge IBSR Database Name:
Insbridge IB_CLIENT Database Name:
Databases Owner User Account:
Databases Owner User Password:
Assign Database User Account as db_owner to IBSR database

[y R

a Configure IBFA

Add Subscriber ID

Add Database Connection for controller pointing to the IB_CLIENT database
Add Database Connection for security pointing to the IB_CLIENT database
Add Database Connection for rm pointing to the IBRM_xxxx database

Add Default RateManager Environment for Rating in Scenario Manager
Configure the Default RateManager Environment

Add SoftRater Environments for loading of SRPs and rating

o000 00D

a Install OBl Publisher
O Start Message Service

a Update component services

a Export and backup Insbridge registry key for safe storage

a Login to RateManager using USERNAME and PASSWORD
a Perform IBRU database updates
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2

Requirements

Server Requirements

A full installation of Microsoft Windows 2000 (either Server or Advanced Server) or Windows
Server 2003 is required. The following configuration assumes that the administrator of the server
to be generally familiar with managing a Windows 200x server.

Required Components

All Windows Server components are available for installation from the Control Panel,
Add/Remove Programs applet by selecting Add/Remove Windows Components. In order to
install these Windows Components, you may be required to have the Windows Installation files
available. The following components are required:

o IIS —Internet Information Services
- Version 5.0 for Windows 2000
- Version 6.0 for Windows 2003
e MSMQ — Microsoft Message Queuing Services
e Microsoft .NET Framework, version 2.0 or version 3.5
e JRE -Java Runtime Environment (not required for a SoftRater Node only install)

Internet Information Services (lIS) 5.0

Required for Windows 2000. The Insbridge Rating and Underwriting System is a web based
application and requires IIS to be installed before the Insbridge Rating and Underwriting System
installation to facilitate the default web virtual directories creations.

The subcomponents of IS needed by the Insbridge Rating and Underwriting System:

e Common Files
e Documentation
o Internet Information Services Snap-In

e SMTP Service — Although not required, the SMTP service will allow the Insbridge Rating
and Underwriting System to notify users via email when extended jobs have been
completed. If the SMTP service is located on a corporate network, then the service must
be properly configured for authorization to relay mail internally to a smart host. Please
check with your information services support group for proper configuration.

o World Wide Web Server
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Internet Information Services (IIS) 6.0

Required for Windows 2003. The Insbridge Rating and Underwriting System is a web based
application and requires IS to be installed before the Insbridge Rating and Underwriting System
installation to facilitate the default web virtual directories creations.

The subcomponents of Application Server needed by the Insbridge Rating and Underwriting
System:

e Application Server Console
- ASP.NET
- Enable network COM+ access
- Internet Information Services (lIS)
e Common Files (default)
e SMTP Service — Although not required, the SMTP service will allow the Insbridge
Rating and Underwriting System to notify users via email when extended jobs
have been completed. If the SMTP service is located on a corporate network,
then the service must be properly configured for authorization to relay mail

internally to a smart host. Please check with your information services support
group for proper configuration.

e World Wide Web Service
- Active Server Pages
- World Wide Web Service
e Message Queuing
o Active Directory Integration (default)
e Common (default)

After installing 1IS, Active Server Pages and ASP.NET v2.0.xxxx must be enabled in order
for the IBRU applications to work.

1. Open Internet Information Services (lIIS) Manager in the administration tools.
2. Select the Web Service Extensions on the left hand side and make sure they are
Allowed as shown below:

'[ Internet Information Services (IIS) Manager

‘_'_ng Eile Action Wiew window Help ‘-Iﬁ'lﬂ

T EE N E I

FJ Internet Information Services . Web Service Extensions
=8 EM {local computer)

-"J Applicétion Pools Select an ikem ko wiew its description, £ I Web Service Extension I atatus I

-"J Web S|tes. . “F al Unknown CGI Extensions Prohibited

---- ~J Vieh Service Extensions “F Al Unknown ISAPT Extensions Prohibited
@ Active Server Pages Allovwed
@ ASPLMET w20.50727 Allowed
@. FrontPage Server Extensions 2002 Allowed
Internet Data Connechor Prohibited
Server Side Includes Prohibited
WebDiY Prohibited

Extended ;{ Standard f

|
Figure 1 Enabling Active Server Pages and ASP.NET v2.0
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Message Queuing Services

Required for Windows 2000 and Windows 2003.The Insbridge Rating and Underwriting system
utilizes the Microsoft Message Queuing Service (MSMQ) for batching jobs and other types of
extended functions. The Microsoft Messaging Queuing Service can be configured for stand-alone
operation without need to access any Active Directory unless specified by your information
support services. The Insbridge Rating and Underwriting System utilizes by default private
message queues that have no need for routing.

Windows Components Wizard [ x| |

Meszage Queuing Type
Fleaze select the type of meszage queuing software o ingtall

Select an MSMO type:

* Message Queling server

kMezzage Queluing zervers store meszsages locally, and can zend and receive
mezzages even when not connected to a network. Fouting provides meszage
gtorage and forwarding services.

[ Enable rauting
[T Manually select access mode to Active Directany

i~ Dependent client

Dependent clientz: da not stare meszages locally, and must be connected ko their
supporting zerver to send and receive messages.

¢ Back I Hest > I Cancel

Figure 2 Message Queuing Type

Microsoft .NET Framework

Required for Windows 2000 and Windows 2003. The installation application attempts to install all
necessary dependencies that may be missing on the IBRU web host and will attempt to install the
Microsoft .NET 2.0 Framework from the web. In some corporate environments, external access to
download the Framework may not be allowed. Therefore, we would suggest installing the
Microsoft .NET Framework version 2.0 prior to starting the Insbridge Rating and Underwriting
System install. This can be obtained from Microsoft’s website or from using Microsoft's Windows
Update.

We also highly recommend installing the .NET Framework after installing IIS in order to update all
the web applications to utilize the ASPNET system. This can be doubled checked by opening
Internet Service Manager and right clicking the Default Web Site, selecting properties, then select
the Home Directory tab. Press the Configuration... button and scroll down to the bottom.
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Application Configuration

App Mappings I App Options I App Debugging I

W Cache 1S4F| applications

—Application M appings

Extensionl E xecutable Path I YWerbz :I
.idq C: MM TS petemn324idg, di GET.HEAD
.asp CAWwWIMM TYS petem32\inetarhazp dll GET HEAD
CET C:AwIMM TYS patem32hinetarhazp.dll GET HEAD
.o CAWIMM TYS petem32hinetsrvsazp.dll GET HEAD
.8%a CAwIMM TYS petem32hinetzr azp.dll GET HEAD
kit CAWIMM T haystem32hinetzrhaszp dil GET.POST
ade C:AwIMM TYSpstem32hinetarehitpodbe. dil OPTIONS.I

.shtm CWIMM T S petem32hineteresine. dll GET.POST
.zhitml CAwIMM TYS petem32hineterhzzine. dil GET.POST

=tm CAWIMM TYS petem32hineterzzine. dil GET.POST

_prinker C:w MM TS wetem32hmaw3prt. dil GET.POST

1| |
gd | Edi Remove |

(1] I Cancel Apply Help

Figure 3 Installing .NET Framework

If you don’t see any of the ASPNET extensions (.asax, aspx, .asmx, etc.) pointing to
%WINDIR%\Microsoft. NET\Framework\v2.0.50727\aspnet_isapi.dll, then the .NET framework
was probably installed prior to installation of IIS.

In order to install the ASPNET ISAPI extensions use the aspnet_regiss.exe located in the
Framework\v2.0.50727 folder. If you want to upgrade all default web applications under IIS to use
the 2.0 framework ASPNET ISAPI, use the following syntax:

C:\WINNT\Microsoft.NET\Framework\v2.0.50727>aspnet_regiis.exe -i

-i - Install this version of ASP.NET and update script maps at the IIS metabase root
and for all script maps below the root. Existing script maps of lower version are
upgraded to this version.

Please see page 76 in regards to the permissions required by the local ASPNET user account.

Installing Java Runtime Environment for PDF creation

This dependency is not required for a SoftRater node installation.

Required for Windows 2000 and Windows 2003.However, in order to create reports as PDF files
from the RateManager web interface, the Java Runtime Environment version 1.4 or above must
be installed on the web server. The JRE can be downloaded from the
http://www.java.com/en/download/
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Special Considerations for Windows Server 2003

Microsoft has identified some known issues with Windows Server 2003. Oracle Insurance is
aware that these issues may surface during the installation of Insbridge Rating and Underwriting
System, depending upon your network setup and choice of operating system. Oracle Insurance
offers the following solutions for known issues. Please discuss and involve your System
Administration Group or IT Department prior to making any change. The suggestions listed below
will allow the Insbridge Rating and Underwriting System to function in most environments. Oracle
Insurance makes no claim to knowing what effects these changes may have on other areas of
your network.

Prior to making any changes, please consult with your System Administration Group or IT
Department and Insbridge support.

FIPS Encryption

PROBLEM: A Windows Server 2003 server with an encryption level set to FIPS Compliant will
not allow Remote Assistance connections from a Windows XP box. When you try to connect, you
will receive an error message.

SUGGESTED SOLUTION: Disable the FIPS encryption.

There are two ways to enable the FIPS encryption level. If you have to disable the FIPS
encryption level for Terminal Services, you must do this by using the same method that you
originally used to enable the FIPS encryption level. *

Method 1

To disable the FIPS encryption level by changing the Encryption level setting in the RDP-
Tcp Properties dialog box, follow these steps:

1. Click Start, click Run, type tscc.msc in the Open box, and then click OK.
2.Click Connections, and then double-click RDP-Tcp in the right pane.

3.In the Encryption level box, click to select a level of encryption other than FIPS
Compliant.

Note If the Encryption level setting is disabled when you try to change it, the system-wide
setting for System cryptography: Use FIPS compliant algorithms for
encryption, hashing, and signing has been enabled, and you must disable this
system-wide setting by using method 2.

1 From Microsoft Knowledge Base Article #811770.
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Method 2

To use the Group Policy Object to disable FIPS data encryption system-wide, follow these steps:

1. Click Start, click Run, type gpedit.msc in the Open box, and then click OK.

2.Expand Computer Configuration, expand Windows Settings, expand Security
Settings, expand Local Policies, and then click Security Options.

3.In the right pane, double-click System cryptography: Use FIPS compliant
algorithms for encryption, hashing, and signing, click Disable, and then click
OK.

Note Encryption level settings in Terminal Server are unavailable when FIPS is enabled.

For more information, please visit http://support.microsoft.com/kb/811770.

Distributed Transaction Coordinator (DTC)

PROBLEM: Network DTC access is disabled by default in Windows Server 2003 server. If
network DTC access is not enabled, applications can only use transactions that are located on
the same box. If you want a client to access the server, you will receive an error message.

SUGGESTED SOLUTION: Enable DTC Access.

Please note that you must restart the server. ?

Steps to enable network DTC access

1. Click Start, point to Control Panel, and then click Add or Remove Programs.
2. Click Add/Remove Windows Components.

3. Select Application Server, and then click Details.

4.Select Enable network DTC access, and then click OK.

5. Click Next.

6. Click Finish.

7. Restart the computer.

If you are running Windows Server 2003 SP1, there are additional steps that must be taken.
Please see http://support.microsoft.com/kb/817064/en-us for more information.

2 From Microsoft Knowledge Base Article #817064.
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Microsoft SQL Server 2000 or 2005

Microsoft SQL Server does not need to be installed on the same machine where the Insbridge
web applications reside. If the SQL Server resides on a separate host from the IBRU web front
end, a properly configured network connection from the web server front end to SQL Server must
exist. Testing can be performed by using the Data Sources application in Administrative Tools to
make a default connection to the database server.

We recommend running your IBRU databases on a SQL Server 2005 instance.

Compatibility level:
IBRM_xxxx = SQL Server 2000
IB_CLIENT = SQL Server 2000
IBSR = SQL Server 2000

All these settings are available during installation of SQL Server or by using SQL
Server Enterprise Manager, and right clicking the server and selecting properties.

If any of these settings conflict with existing application’s databases residing on the
SQL Server, then a separate instance is required.

Depending on the load expected on the web server, the database can be placed on a separate
SQL Server that can either be independent or shared as long as the following conditions are met.
All settings are relevant on both SQL Server 2000 and 2005 instances:

e SQL Server must use Mixed Mode Authentication.

S0l Server Properties (Configure) - DE4

Server Settings ] Database Settings ] Replication ] Active Directory ]
General ] Memory ] Processor Security l Connections ]

Security

SQL Server provides authentication based on Windows
accounts and a named SQL Server login 1D and password.

Authentication:

" Windows only

Audit level:
* MNone " Failure
" Success Al

Startup service account

Start and run SQL Serverin the following account:
ay {* System accourt

" This account

QK | Cancel | Help |

Figure 4 Setting SQL Server
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e NT Fibers must not be enabled (not enabled by default).

S0L Server Properties (Configure) - DB4

Server Settings ] Database Settings ] Replication ] Active Directory ]
General ] Memary Processor Security ] Connections ]
Processor control

In a symmetric multi processor {SMP) environment, specify
% which processors SQL Server will use.

Processor

7] CPU 0 - PROCESSOR_INTEL_PENTIUM
CPU 1-PROCESSOR_INTEL_PENTIUM

Maximum worker threads: 255

=~
[V Boost SGL Server priority on Windows
I~ Use Windows NT fibers

Paralielism
% Specify the number of processors to use for parallel execution of
quenies:

& Uss all available processors

" Use

Minimum query plan threshold for considering 5 =1
queries for parallel execution (cost estimate): =
+ Corfigured values " Running values

QK | Cancel | Help |

Figure 5 Disabling Windows NT Fibers

e Collation and Sort Order: Currently supported are the default SQL Server collation and
sort order plus case sensitivity using Latin1_General_BIN as the server collation. Check
with Insbridge for any questions regarding database server sort orders or collations.

IN[@JR=]] For SQL Server 2005, please make sure the SQL Server Client is installed.

MDAC 2.8

If the Insbridge Rating and Underwriting application is split between a web server and a database
server, then Microsoft's Data access component version 2.8 needs to be installed on the web
front-end server.

MDAC version 2.8 or greater is required for the IBFA for SQL Server 2000.
NOTE
MDAC version 2.8 is included with Windows Server 2003.

To check to see if MDAC is installed, go to: Start>Control Panel>»Add or Remove Programs and
scroll through the list. If it is not installed, you can download it from Microsoft’'s web site.
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Insbridge Local User Account Setup

Before starting the installation, create a local user account where the Insbridge Framework is
being installed. This user needs to be a member of the Users group and requires certain
privileges in order to fully control the entire IBRU environment. For ease of installation and if the
server is dedicated to the Insbridge Rating and Underwriting System, we suggest adding this user
to the local machine Administrators group.

To create a new user:

Right click the My Computer icon on the desktop.
Select Manage from the drop down list.

Select Local Users and Groups.

Select Users.

Right click on the right side of the screen.

Select New User.

2 o

There are some slight variations between Windows 2000 Server and Windows
Server 2003. These variations will be pointed out as they occur.

NOTE

O Computer Management E @ |
g File  Action  Wiew  Window  Help .= J
& ol e =
=) Computer Management (Local) Name Full Hame Descriptian
= ﬁ& System TD':'!S F\dministratnr Built-in account for administering the...
E:EthV'ELT;r lg.ﬂtSF‘NET ASP.MET Machine Account Account used For running the ASPN. ..
% f arrl_l Fol ersd < lgGuest Built-in account For guest access to k...
DER S And faroups %Helpnssistant Remate Desktop Help Assi,..  Account For Providing Remate Assist, ..
lgIUSF‘\_F‘LQ.C\.D... Internet Guest Accounkt Built-in account For anonymous acce, ..
| lmI'\a‘\-'.\?'.r\ﬂ_PLQ.D.. .. Launch IIS Process Account  Built-in account For Inkernet Informa. ..
Mary

lgSUF‘PORT_SS. .. CM=Microsoft Corporation...  This is a wendor's account For the He. ..

Rermovable Starage
Disk Defragmenter
Disk Management
@ Services and Applications

Figure 6 Creating New User

Add a new user using the following information:
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New User, @g|

User name: |nzbridge

Full name: [BRU User
Description: [BRU User
Pazzward: TIIII L]
Confirn pazsword: LT L)

I1zer cannot change password
Paszword never expires
[ ] &coount iz disabled

Create I [ Cloze

Figure 7 Adding User information

The password can be set to any password and the administrator of the Insbridge Rating and
Underwriting System must make note of the password for future configuration. For future
reference, a space is provided below to store the password.

INSBRIDGE USER PASSWORD:

For ease of maintenance of the Insbridge Rating and Underwriting System, this user should not
have to change the password and the password should never expire. After this user is created,
the user will be assigned to the local Users group. Double check the Users group to make sure
the Insbridge user was added. If the Insbridge user is not listed in the Users group, add them at
this time. The Insbridge user also can be added to the local Administrators group at this time.

If the Insbridge Rating and Underwriting System is shared and this user cannot be a part of the
local administrators groups, additional installation steps must be performed. See page 77.

Please note that if your company requires passwords to be re-set, you will have to make changes
to the COM+ Application libraries after you change your password. The installation will
automatically apply the Insbridge user name and password to the necessary libraries. If you
change the password, you will have to change the password in all three of the Insbridge Com+
libraries. On each library, right click, select Properties, select the Identity tab, enter in the new
password.
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3

Full Installation Procedures

The installation must be performed in the following order:

Install IBRU
There are three permissions you must assign before you can continue.
- Registry Access
- Temp Folder for MSMQ
- Insbridge Folder
Creation of the IBRU databases is next. There are three databases that must be in place.
- IB_Client
- IBRM
- IBSR
Configuring the IBFA.
- Adding your subscriber information.
- Adding database connections.
- Adding and defining your environment.
Updating Component Services.
Exporting Registry Key.
Installing OIB Publisher.

The download files you receive will be zip files. Unzip the file to the machine where RateManager
and Insbridge Framework will be located.

For this part of the install, you will need the 3.12.0 Insbridge IBRU folder. Folder includes:

1.

3.12.0-Insbridge-IBRU folder
- Databases
Oracle folder
- SoftRater — IBSR
o Usp IBSR v03.12.0.oracle
SQL Server
- RateManager — IBRM
0 IBRM_TEMPLATE.mdf
- Security — IB_CLIENT
0 IB_CLIENT_TEMPLATE.mdf
- SoftRater — IBSR
o IBSR_TEMPALTE.MDF
o Usp_IBSR v03.12.0
- |E7 Users
Insbridge IE7 Active X Registration PDF
RateManager_IE7
- Oracle Bl Publisher
OBI_PUBLISHER
- Oracle Client
- Oracle Insurance - Insbridge Rating and Underwriting Install file
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Insbridge Rating and Underwriting Installation

Begin with Oracle Insurance - Insbridge Rating and Underwriting Install file.

During the installation, the installation program requires the installer have administrator rights on
the machine where the install is occurring. Please close all open applications and run the Oracle
Insurance — Insbridge Rating and Underwriting file.

A Welcome screen will be displayed.

i Oracle Insurance - Insbridge Rating and Undemwriting 3.12.0/5... E||E|E|

4 Oracle Insurance Insbridge Rating and Underwriting

[t iz strongly recommended that you exit all Windows programs befare running this setup program.

Click Cancel to quit the getup pragram, then cloze any programs pou bhave running. Click Hest to
continue the installation,

WARMIMG: Thiz program iz protected by coperight lavw and international treaties.

Ilnauthorized reproduction or distriibution of this program, or any portion of it, may result in severe civil
and criminal penakties, and will be prozecuted ta the masimurn extent pozsible under law.

ORACLE

INSURANCE

mEHU i [ Cancel

Figure 8 Installing Insbridge

1. Click Next to continue.

Oracle Insurance Insbridge Rating and Underwriting Installation and Upgrade Guide Page 21



i% Oracle Insurance - Insbridge Rating and Underwriting 3.12.0 S... E_||E|E|
Destination Folder ORACLE

Select a folder where the application will be installed. INSURANGE

The "Wize [nstallation “Wizard will inztall the files for Oracle Insurance - Ingbridge R ating
and Undenwriting in the following folder.

Toinstall into a different folder, click the Browse button, and select another folder.
Y'ou can chooze not ko install Oracle Insurance - Insbridge B ating and Underwriting by
clicking Cancel bo exit the Wize [nstallation 'wfizard.

Destination Folder
C:%Program FilezhOracleh GE LU nzbridge,

Wize [nstallation Wizard [R]

¢ Back ][ Mest = ] [ Caricel

Figure 9 Entering the Destination Folder for Insbridge

2. Choose the location where the Insbridge installation will be located. This will be the location
for all future installations for Insbridge applications. Click Next to continue.
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i% Oracle Insurance - Insbridge Rating and Underwriting 3.12.0 S... E_||E|E|
Logon Information DRACLE

The following logon information iz used by Inzbridge. INSURANGE

Specify a uzer account bo be wzed by the application, either for running a service ar for
logging onto ather servers, Use the Browsze button to choose wzers from pour nebwork.,
For domainz, uzer names must be in the format of DOMAIR S zerd ame.

Pazzwaord:

EERETTET

[ Create Mew zer...

Wize [nstallation Wizard [R]

¢ Back " Mest = ] [ Caricel

Figure 10 Logon Information

The logon information screen will be displayed. You must specify a user account to be used by
the application. Please use the Insbridge user account that you set up earlier.

It is not recommended to Create a New user at this point. Specific permissions must be held by
this user. You may not be able to create a new user with those permissions at this point.

3. Enter the Insbridge user name and password for the local user account you set up earlier.

4. Click Next to continue.
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The next screen will list the applications to be installed. To expand the options and view details,
click on the downward arrow. All features are checked for installation. RateManager is the only
one that you will be allowed to not install.

i& Oracle Insurance - Insbridge Rating and Undenwriting 3.12.0 S... E”E|E|
Select Features DRACLE‘

Fleaze zelect which features you would like to install
g INSURANCE

Feature Description:
R atebd ananer allmws husinezs uzers to create,
= wil be installed on local hard drive, w rates and rules

= v| . tting engine in an

=38 Entire feature will be installed on local hard drive.

I Insl:uru:lge Hatlng & Underwntmg

=0 Feature will be installed when required. an the local hard

¥ Entire feature will be unavailable,
TTilE TEatine regquires 2em6 on your hard drive.

Current location:
C:4%Program FileshOraclet| GBI nsbridge

Wize [nstallation wizard [R]
[DiskEDst] [ Reset ] [ < Back " R =E ] [ Cancel

5. Click Next to continue.
Options are:

e Insbridge Rating and Underwriting:
- The default option is: Entire feature will be installed on local hard drive.
- You will not be able to opt out of this selection.

¢ RateManager:
- The default option is: Entire feature will be installed on local hard drive.
- You will be able to opt out of this option. Select Entire Feature will be
unavailable. RateManager will not be installed. You do not need to install
RateManager when you are installing a SoftRater node only.

e IBFA:
- The default option is: Entire feature will be installed on local hard drive.
- You will not be able to opt out of this selection.

e Oracle Bl Publisher:
- The default option is: Entire feature will be installed on local hard drive.
- You will not be able to opt out of this selection.
- This option does not install the OBI Publisher. Only the templates required by the
IBRU application will be installed on local hard drive.
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i% Oracle Insurance - Insbridge Rating and Undemwriting 3.12.0° 8. .. |Z||E|[z|
Ready to Install the Application ORACLE

Click Mest to begin installation. INSURANGE

Click the Back button to reenter the installation infarmation or click Cancel to exit
the wizard.

Wize [nstallation Wizard [R]

¢ Back ]MEHD i [ Cancel

6. A Ready to Install screen will be displayed. If you are ready, click Next. Otherwise click Back
to check the options you want to install.

i Oracle Insurance - Insbridge Rating and Underwriting Setup E|E| X
Updating System ORACLE

The features you selected are curently being installed.

INSURANCE
Copying new files...
File: Diff_Report.itf
Directary: C:A\Program Files\Oracleb GB U nebridgetFrameworkh2 0.0% 5
Size: F22323

YWize [natallation Wizard [R]

Cancel
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i% Oracle Insurance - Insbridge Rating and Underwriting 3.12.0 S... E_||E|E|
Readme Information DRACLE

Inzbridge has been successfully installed. INSURANCE

Microsoft Windows 2000/2003 Server ~
A full installation of Microsoft Windows 2000 (either Server or Advanced Server)

or Microsoft Server 2003 is required. The following configuration assumes that

the administrator of the server to be generally familiar with managing a YWindows
server.

Components of Windows 20002003 Server

All Windows Server components are available for installation from the Control
Fanel, Add/Rermove Programs applet by selecting Add/Remove Windows
Components. In order to install these YWindows Components, you may be
required to have the Windows Installation COROM available.

Internet Information Services (I15)
The InsBridge Rating and Underwriting Systerm is a web based application and  »

YWize [nstallation Wizard®
| <Back | Firish | | Carcel

Figure 11 Install ReadMe Screen

7. Click Finish to finish the installation. The update should complete successfully.
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Configuration of the Insbridge Framework Components

Configure Registry Access for Windows 2000 Server

If you use Registry Editor incorrectly, you may cause serious problems that may
(WYZANRNIN[ER require you to reinstall your operating system. Insbridge cannot guarantee that
you can solve problems that result from using Registry Editor incorrectly.

By default, only administrative and power user accounts have full permissions over this key. The
Insbridge user must also be given full control over the following registry key:

HKEY_LOCAL_MACHINE/SOFTWARE/Insbridge

You can perform this by:

1. Select Run from the Start Menu.
2. Type regedt32. Click OK. The Registry Editor will open.
3. Browse to HKEY_LOCAL_ MACHINE. Select SOFTWARE > Insbridge.

= Registry Editor - [HKEY_LOCAL_MACHINE on Local Machine]

n Registry  Edit Tree Wiew Security Ophions  Window  Help ;lilil
— 3 Cisco Systems N
— 3] Classes
— 3 Clients

— 30 ComputerAssociates
— 5 Deterministichletworks

— 3 InstalledDptions
—E= INTEL

— G KO

— 33 Microsoft

—E METGEAR
—3 ODBC

— 33 Policies

— 1 Program Groups
— 1 Secure

— 3 Woice

-3 Windows 3.1 Migration £

L 2SS TFM =
| | »

Figure 12 Configure Registry Access Windows 2000 Server

Select Security from the Registry Editor top bar menu.

Select Permissions.

Click Add.

On the Select Users or Groups popup, select the directory you need to Look in.

No ok
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i select Users or Groups

Look in: IQ ghnaire. com j
| In Folder Iil

M amne

ﬁ inzbridge ghywire com/U sers

ﬁ.ﬁ.NDNYMDUS LOGOM skywire. com/U sers

€7 futhenticated Users skiywire. comy sers

€7 BATCH shywire. com//L sers

ﬁ CREATOR OWMER skmaire. comdU zers J
ﬁ DlaLUP ghomwire. com/U sers

€T INTFRACTIVF skpwire.com/Users ;I

Add Check Mames

<< Tupe names separated by semicalon: or chooze from list >

[ Cancel

o

Figure 13 Selecting the insbridge user

8. Scroll until you find the insbridge user. Click Add and then OK.
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Permissions for Insbridge EH |

Security |

M arne - Add... |
ﬂ [BRU Uzer [zkywire. combinzbridge]

m Power Users [skywire. com'Power Uzers] ﬂl
€7 SvSTEM

ﬁ TERMINAL SERVER USER

I IQ‘FIT'{" rQ'lc'Illl‘ulirFi I"'I'Il'ﬁl'ul |<‘-|=-r<~'| bl
1 | »

Permizzions: Alloy Deny
Fead O
Full Control O

Advanced... |

™ Allov inheritable permiszions from parent to propagate to this

ohject
k. I Cancel Apply

Figure 14 Setting Permissions

9. On the Permissions screen, make sure the insbridge user is highlighted and check to
give Full Control to the entire Insbridge key.
10. Click OK. You can close out the Registry Editor.

Configure Registry Access for Windows Server 2003

If you use Registry Editor incorrectly, you may cause serious problems to the
operating system. These problems may require you to reinstall your operating
system. Insbridge cannot guarantee that you can solve problems that result from

using Registry Editor incorrectly.

WARNING

By default, only administrative and power user accounts have full permissions over this key. The
insbridge user must also be given full control over the following registry key:

HKEY_LOCAL_MACHINE/SOFTWARE/Insbridge
You can perform this by:
1. Selecting Run from the Start Menu.

2. Type regedt32. Click OK. The Registry Editor will open.
3. Browse to HKEY_LOCAL_MACHINE. Select SOFTWARE > Insbridge.
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%' Registry Editor

File Edit Wiew Favorites Help

=] B MMy Computer
[Z HKEY_CLASSES_ROGT
(2 HKEY_CURREMT _UISER,
=20 HKEY_LOCAL_MACHINE
() HARDWARE
0 sam
(3 SECURITY
[ SOFTWARE
(L0 corfsy
(2] Classes
(23 Clients
2 Gemplus
23 GMu
=T oo
23 tntel
(23 Microsol
3 Mozilla
23 Mozillap Delete
{23 Hico Ma
(L oDBC
(C3 oraclet  Expart
(L ORCLoH i
(23 policies

Expand

Rename

(21 schiumberger
D Secure
(21 symantec
(21 symanteciolatils
23 ¥Mware, Inc.
(23 Windows 3.1 Migration
(2 svsTEM
(20 HKEY_USERS
(2 HKEY_CURRENT_CONFIG

< | B

Mame

[ab]pefaulty

D Progran Copy Key Mame

My Computer\HKEY _LOCAL_MACHIME,SOFTWARE\Insbridge

Figure 15 Configure Registry Access Windows Server 2003

4. Right click and select Permissions.

5. Click Add.

6. On the Select Users or Groups popup, select the Object Types and Locations.

Select Users or, Groups

Select thiz object type:

|L|sers, Groupz, or Buil-in security principals

| [ Object Types. .. l

Erarn thiz location;

| PLOADOCOT

H Locations... ]

Enter the object names to select [examples]:

inshridge]

Check Mames

H Cancel ]

Figure 16 Entering the User
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7. Enterin the user name (insbridge) and click Check Names. If the user name is found, it
will be listed. If the name is not found, and error screen will be displayed. Cancel out and
to return to the Select Users or Groups popup. Click Advanced to search. To search the
directory, click Find Now and scroll through the list until you find the user name you need.
If the user name is not listed, return to User Accounts and verify the user name was
created.

8. Once the name is listed, click OK.

Permissions for Insbridge

Security

Group or user names:

ﬁ Administrators [PLAADOCOT Administrators] ~
€7 CREATOR OWNER

ﬂ Inzbridge [PLAADOCON Mnshbridge]

€ Mary PLOADOCO M any]

T D e (D1 MAROUETA L Dmr e | Ll

£ ?

[ Add... H Bemove ]

Permizzions for |nsbridoe Al Deny
Full Contral ]
Read O

Special Permizsions

For special permizzions or for advanced settings,
click Advanced. =

] 4 l[ Cancel ][ Apply ]

Figure 17 Applying Permissions for 2003 User

9. On the Permissions screen, make sure the insbridge user is highlighted and check to
give Full Control to the entire Insbridge key.

10. Click OK. You can close out the Registry Editor.

Windows Temp Folder for MSMQ

Microsoft .NET requires that the user sending messages using Microsoft Message Queue
(MSMQ) have full access to the WINNT\Temp folder (on 2000) or the WINDOWS\Temp folder (on
2003). The insbridge user created on page 18 should be given full permissions.

The basic pathway is the same for both 2000 and 2003. The screens involved are similar to the
ones pictured in Configuring Registry Access.

For 2000, this can be performed by going to your system setup drive (most likely the C drive):
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1. Open Windows Explorer. Find the WINNT folder, most likely on your C drive.

File Edt \‘iew Favorites Tools Help |
Back + = - | Q) search |%FOIders 4 | 5 E ¥ o | -
Address [ c:ywInnT =] @eo

Folders x

addins -

{:l application Compatibility Script: WINNT

{11 appPatch
-2 assembly This Falder cantains files that keep

{2 corfi your system working propetly, There is

3 no need to modify ks contents,

{20 Connection Wizard

{23 Cursars To wiew the contents of this folder,
-0 Debug click: Show Files

-{#] Downloaded Program Files
E]--D Drriver Cache

--{_1 Fonts

-0 Help

-3 1s Temporary Compressed File
e

=23 java

D Media

-0 Microsoft NET

23 msagent

=3 msapps

i )

B ez

-4 offl Expand
ECdpcr—————
53 Req Explore
[JReg 2Pen

{2 rep Search...
{1 Sch Sharing. ..

E]--D secl
[]..{:l Ser Send To 3
IZEZI--{:I Soft  cyp
Osee copy

-3 sun

-{Z syst| Delete -
[]..D syst Rename
(3 Tasl

"{:I biaain_32

{1 web

{7 windows Update Setup Files

{:l winsxs -
. - I _>I_I

|15? object(s) (plus 46 hidden) (Disk free space: 651 ME) 5.91 MB |Q My Computer 4

Figure 18 Windows Explorer WINNT 2000 Properties

Right click the WINNT>»Temp folder.

Select Properties.

Change to the Security tab.

Click Add.

On the Select Users, Computers or Groups popup, select the directory you need to Look in.
Scroll until you find the insbridge user. Click Add and then OK.

On the Temp Properties screen, make sure the insbridge user is highlighted and check to
give Full Control.

9. Click OK.

© N ok W
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For Windows 2003, the procedure is similar.

1. Open Windows Explorer. Find the WINDOWS folder, most likely on your C drive.
2. Right click the Windows>»Temp folder.

File Edit Wiew Favorites Tools  Help "
eBack M > ) lﬁ pi ) Search [F‘ Folders '
address |E| £ WINDOWS| Temp V| =] Go
Folders x
1= msapps ”~

E] mui

L network diagnost

E] Oembir

OFfline \Web Page
I3 ORCLOBT
[ pchealth
El Peerhet
I Prefetch
L Provisioning
[T RegisteredPacka
IC) Registration
E] repait
[ Resources
5 security
|5 ServicePackFiles
[ SoftwareDistribut:
[ stchasst
E] syskem
I systemaz
.,j Tasks
=
El bvwain
I web
1L wins
L5 WHPYOL_EN
9- Control Pang
[ Shared Dacul Sharing and Security. ..
[ Mary's Docun S WinZip L4
Q My Metwark Place
2 Recycle Bin

Explore
Open
Search...

Send To ’

Cuk
Copy

< |

Delete
Rename

Figure 19 Windows Explorer WINNT 2000 Properties

3.
4.
5.
6.
7.

Select Properties.

Change to the Security tab.

Click Add.

On the Select Users or Groups popup, select the Object Types and Locations.

Enter in the user name (insbridge) and click Check Names. If the user name is found, it
will be listed. If the name is not found, and error screen will be displayed. Cancel out and
to return to the Select Users or Groups popup. Click Advanced to search. To search the
directory, click Find Now and scroll through the list until you find the user name you need.
If the user name is not listed, return to User Accounts and verify the user name was
created.

8. Once the name is listed, click OK.

9. On the Temp Properties screen, make sure the insbridge user is highlighted and check to
give Full Control.

10. Click OK.
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Permissions for Insbridge Folder Location

Full access also must be given to the Insbridge user created on page 18 to the installation
location for the Insbridge folder. This is the location you selected to install the IBFA, most likely
C:\Program Files\Oracle\IGBU\Insbridge.

By default administrators are given full permissions to the local server file system. If the Insbridge
user was not given Administrative permissions then they must be given full control over the
Insbridge folder.

For 2000:

1. Open Windows Explorer. Find the Programs folder. Select the Oracle folder. Select the
IGBU folder. Select the Insbridge folder.

B Inshridge

Fle Edit ‘iew Favorites Tools Help

Q Back - d l% /..-\’ Search v

Address ‘E| C:\Pragram Files\Oracle\1GEUN Insbridge v| Go
x

Folders — o —\_,
= My Camputer ~ (":} COM+ D Framewark (":} SDK
oy

[[" Folders

\ﬂ 344 Floppy (A1)
= % Local Disk () ——
[C5) 2040f6FaSeeta51c15 D SoftRater
(5 Documents and Settings
(£ Inetpub
= [ Program Files
1) Common Files
1) ComPlus applications
IC3) Internet Explorer
@ Messenger
IC5) microsoft frontpage
1) Movie Maker
5 MEuild
[ MaN
[5) MSH Gaming Zone
El MetMeeting
5 online Services
B I3 oracle B
= ) 1GEU
(=)
IE5) Outloak Expre
[C3) Reference Az Explore
I Symantec Qpen
[0 Symantec An| Search...
150 YMware

‘webs

o

Expand

Sharing and Security...
3 WinZip ¥

Send To 3

Zuk
Copy

Delete

Rename

Figure 20 Insbridge Folder Properties

Right click the Insbridge folder.

Select Properties.

Change to the Security tab.

Click Add.

On the Select Users, Computers or Groups popup, select the directory you need to Look in.
Scroll until you find the insbridge user. Click Add and then OK.

On the Insbridge Properties screen, make sure the insbridge user is highlighted and
check to give Full Control.

© N ok wWN
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9.

InsBridge Properties |

Generall wieb Sharingl Sharing Security |

Hame - Add...
ﬂ [BRU Uzer [zkywire. combinzbridge]
m Power Users [skaire. com'Power Uszers] __
€7 SvSTEM

ﬁ TERMINAL SERVER USER

I IQ‘FIT'{" rQ'lc'Illl‘ulirFi I"'I'Il'ﬁl'ul |<‘-|=-r<~'| bl
1 | »

Permizzions: Alloy Deny

[

Bemowve

Full Control

b odify

Read & Execute
List Folder Contents
Read

Wirite

Advanced... |

™ Allov inheritable permiszions from parent to propagate to this

ohject
k. I Cancel Apply

Figure 21 Setting Permission for Insbridge Folder
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Click OK. You can close out Windows Explorer.

For 2003 the procedure is similar:

Noos~ON =

Open Windows Explorer. Find the Programs folder. Select the Insbridge folder.
Right click the Insbridge folder.

Select Properties.

Change to the Security tab.

Click Add.

On the Select Users or Groups popup, select the Object Types and Locations.

Enter in the user name (insbridge) and click Check Names. If the user name is found, it
will be listed. If the name is not found, and error screen will be displayed. Cancel out and
to return to the Select Users or Groups popup. Click Advanced to search. To search the
directory, click Find Now and scroll through the list until you find the user name you need.
If the user name is not listed, return to User Accounts and verify the user name was
created.

Once the name is listed, click OK.

On the Insbridge Properties screen, make sure the insbridge user is highlighted and
check to give Full Control.
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InsBridge Properties |

Generall Yweb Sharingl Sharing Security |

M ame -
ﬁ [BRU Uzer [zkwwire. comhinzbridge]

Add...
€72 Power Users [skywire.com'Power Users) __| = Bemave |

€7 SYSTEM
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| lzrre ok maire cormh lears] -
1 | »
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Full Cantral O =
b odify O
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Lizt Folder Contents O
Fead O
Wit O &
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For special permizzions or for advanced settings, Advanced |
click Advanced. =
k. I Cancel | Apply |

Figure 22 Setting Permission for Insbridge Folder

10. Click OK. You can close out Windows Explorer.
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IBRU Database Creation and Installation in SQL Server

It is strongly recommended that any database modification be performed by a
qualified database administrator (DBA). The database setup procedures and

tasks require the skill set of a database administrator. If you are not a
IMPORTANT database administrator, please stop. Improper setup may result in unwelcome
changes to the database. Please consult with a qualified database
administrator before proceeding.

Before attaching the databases:

1. Create a SQL Server account called ibru with a password that meets your company
standards.

2. Framework Administrator templates. The database template file
IBSR_TEMPLATE.mdf is used to update the SoftRater database. This file must be run in
SQL Server when the installation is complete. This file is not version specific and is the
only update file for SoftRater, even if you are going from a version lower than 3.11.

3. RateManager templates. The database template files IB_CLIENT _TEMPLATE.mdf and
IBRM_TEMPLATE.mdf are used to update the RateManager database. These files are
version specific and must be run sequentially when the installation is complete. The
database update scripts in the RateManager folder will take you from a 3.11 version to a
3.12 version only.

If you need to go from a lesser version, such as 3.9, you will have to enter
RateManager and run the IBRM and IB_CLIENT update scripts in sequential order
from there. You must be a DB Owner to run the update scripts in RateManager.

You also can save the scripts from RateManager and run them in SQL Server. Be
sure to run the scripts in sequential order.

See Manual Updates to the IBRU Databases for more information.

Databases and User Required for Each Installation Type

The table below shows which databases and database users are required for each type of
installation.

Installation Type
Database RateManager SoftRater
IB_CLIENT Yes Yes
IBRM_ XxXxx Yes No
IBSR No Yes

If performing just a SoftRater node installation, you do not have to retrieve
IBRM_TEMPLATE.mdf.
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For SQL Server 2000

Because many corporate environments have a separation between the system administrator and
the database administrator, the following process may require both administrators’ access and
permissions. Make sure you have a SQL Server account called ibru.

If you do not have database permissions, you will not be able to perform the following
database procedures.

NOTE

If you are unsure how to perform a database restore, please consult with your
database administrator.

1. Copy files. The IBRM_TEMPLATE is located in the Databases> Sq|
Server>»RateManager folder and the IB_CLIENT_TEMPLATE database file is located in
the Databases>» Sql Server> Security folder. The IBSR_TEMPLATE file is located in the
Databases»Sql Server> SoftRater folder. Copy all three files to an appropriate database
folder on the machine where SQL Server is installed. For example, [Drive]:\\Program
Files\Insbridge\Databases. If you are unsure of a location, please contact your database
administrator.

NOTE If performing just a SoftRater 3.12 installation then the only databases needed are
the IB_CLIENT_TEMPLATE and IBSR_TEMPLATE.

2. Rename files. It is not required but it is strongly suggested that the database file names
be changed from TEMPLATE to something that defines the databases more accurately.
At a minimum, it is recommended that you remove “ TEMPLATE” from the name. You
can change the names after they have been attached also.

3. Open the SQL Server Enterprise Manager either on the server or remotely using either
an administrative account with sa privileges or as the sa account.

4. Browse under the DBServer to the Databases.

Tﬂl SQL Server Enterprise Manager - [Console Root'\Microsoft SQL ServersiSQL Server Group' {local) {Windows NTYD... [I[=]
J% Console  Window  Help |_|- _IEI 5'
[ o _ton 1o || & > |G| X 2 BB |5 |80 B |

Tree I Databases 34 Ikems

[ Console Rook -
=] Microsoft SQL Servers

E@ SOL Server Group IB_CLIEMT  IBRM_33_T... IBSR master
EIH’ (lacal) (Windows MT)
5

-k € MewDatabase...

Backup Database. .. sdsvrgatp tempdh
Restare Database, .. (Single User)

i 3
Mew window From Here

Attach Database. ..

Import Data. ..

Refresh
elres Export Daka...

Export List...
B2 Data® Copy Database Wizard. ..
-2 Manar -]y T T

{21 Replication

[]--D Security LI

|
Figure 23 Setting up a SQL Server 2000 Database
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5. Right click on Databases.
6. Select All Tasks.

7. Select Attach Database... A separate screen will be displayed.

Attach Database - {local) E |
MOF file of database to attach:
I | Werify I

Original File Mame(z] |Eurrent File[z] Location |

1| | ]

Aftach as: I

Specify databaze owner: I Inzbridge j

] Cancel Help |

Figure 24 Attaching a Database

8. Click the search button _ - |and browse to the location where the database files were
placed in step 1.

9. Attach database IB_CLIENT xxxX.MDF, where xxxx equals the renamed file from
step 2.

Attach Database - {local) |

MOF file of database to attach:

I D:4DatabasehnzbridgehDEs4E_CLIEMT. mdf

Original File Mame(z] |Eurrent File[z] Location |:|
[B_CLIEMT.dat W D:\Databasetlnsbridge’\DBsMB_CLIEMT dat
|[B_CLIEMT.log W O:\DatabazelnsbridgedDB 2B _CLIENT Jog
1| | »

Attach as: IIE_ELIENT

Specify databaze owner: Ilnsbridge j

] Cancel Help |

Figure 25 IB_CLIENT_xxxx Attached

Oracle Insurance Insbridge Rating and Underwriting Installation and Upgrade Guide Page 39



10. Delete the log file. The log file must be deleted to prevent an error. For SQL Server

2000, erase the Current File Location for the log file.

11. If necessary, rename the IB_CLIENT_ xxxx.dat file to IB_CLIENT_ xxxx.mdf.

12. Change the Attach as: file name to the file name you assigned in step 2.

Attach Database - (local)

MDF file of databasze to attach:

ID:'xDatahase'\lnshridge'xDE!s'\IB_ELIENT.mdf | Werify I

]|

Current File[z] Location

IE CLIEMTlog

Kl |

Aftach as: IIE_ELIENT
Specify database owner; Ilnsl:uridge j
k. Cancel Help |

Figure 26 Editing the Database before Attaching

13. After you have made your edits, click OK.

14. The system will create a new log file for this data base, click Yes.

SQL Server Enterprise Manager |

& The filename specified far the log Ffile is incorreck,

& news log File may be created.
Do you wank bo continue?

15. If the database was attached successfully, a success message will be displayed. If not,

please correct any errors and try again.
SOL Server Enterprise Manager |

@ Attaching database has completed successFully,

Do the same for the IBRM_xxxx and IBSR databases depending on your installation type.
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Once the databases are attached to SQL Server, you will need to create or assign a SQL Server
user account for the application. This user will be used for the connection to the databases when
setting up the connections from the Insbridge Framework Administrator.

If backups are to be allowed from the RateManager application (see page 36 for more details),
then the ibru SQL server user account must have the Disk Administrators SQL Server role.

For ease of administration, the database user should have db_owner permissions on the
IBRM_xxxx , IB_CLIENT, and IBSR database. See page 76 for further details on tightening user
permissions.

For SQL Server 2005
Because many corporate environments have a separation between the system administrator and

the database administrator, the following process may require both administrators’ access and
permissions. Make sure you have a SQL Server account called ibru.

If you do not have database permissions, you will not be able to perform the following
database procedures.

If you are unsure how to perform a database restore, please consult with your
database administrator.

1. Copy files. The IBRM_TEMPLATE is located in the Databases> Sq|l
Server>»RateManager folder and the IB_CLIENT_TEMPLATE database file is located in
the Databases>» Sql Server> Security folder. The IBSR_TEMPLATE file is located in the
Databases> Sql Server» SoftRater folder. Copy all three files to an appropriate database
folder on the machine where SQL Server is installed. For example, [Drive]:\\Program
Files\Insbridge\Databases. If you are unsure of a location, please contact your database
administrator.

If performing just a SoftRater 3.12 installation then the only databases needed are

NOTE the IB_CLIENT_TEMPLATE and IBSR_TEMPLATE.

2. Rename files. It is not required but it is strongly suggested that the database file names
be changed from TEMPLATE to something that defines the databases more accurately.
At a minimum, it is recommended that you remove “ TEMPLATE” from the name. You
can change the names after they have been attached also.

3. Open the SQL Server Management Studio either on the server or remotely using either
an administrative account with sa privileges or as the sa account.

If you do not have SQL Server Management Studio, check to see that the SQL
IN[ORR=N Server Client has been installed. For a SQL Server 2005 install, you must have the
SQL Server Client installed.
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Figure 27 Attaching a Database to SQL Server 2005

4. Go to Databases.

R Microsoft SOL Server Management Studio =] &3

Eile Edit ‘iew Tools ‘Window Community Help

Qiowaey | BB LB EHEES DEBES,

0 4 ~ 1 x Object Explorer Details | - X
Comnect~ | 32w T (3] BEE T ‘
Bl [{§ SOUTHERN (SQL Server 90,3042 - SKVWIRE\l:'
-
Mo Daabass... Databases
OUTHERNIDatabases a1 It
= [ Ager attach,.. | ems)
[ ] Restore Databass. ..
1y R 3 Restore Files and Filegroups... -
U AR3 tem Databases
U AR_3 Reparts ¥ labase Snapshots
U 2:-3 e EntRater_Auditing
H g S 3_3_CLIENT_PIC
= —
it AR_4_0_TH
|1 1BRM_WF_36 BAR*"*U*HH 4
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Figure 28 Right Click to Attach Database

5. Right click on Databases.

6. Select Attach... A separate screen will be displayed.
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. Attach Databases _ O] x|

Select apage 5 Script - m Help

2 General

Databases to attach:
_I MOF File Location | Catabaze ... | Aftach Az | Owaner | Status | tessage |

FEemove |

Databaze details:

Original File Mame | File Type | Current File Path | Meszage |

Server
soLthem

Connection:
SKYWIRE g

2¥ Wiew connection properties

Ready

Femaowve |

0K | Cancel |

4

Figure 29 Attaching a Database

7. Click the Add button and browse to the location where the database files were placed in
step 1.

8. Attach database IB_CLIENT _xxxx.MDF, where xxxx equals the renamed file from
step 2.
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Select the file:
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Figure 30 IB_CLIENT_xxxx Attached

9. Click OK.
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. Attach Databases !E E3
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Figure 31 Editing the Database before Attaching

10. Delete the log file. The log file must be deleted to prevent an error. For SQL Server
2005, highlight the log file in the Current File Path area and click the Remove button.

11. Make sure the original file name has an .mdf extension and not a .dat extension. If the
file is IB_CLIENT_ xxxx.mdf and not IB_CLIENT__ xxxx.dat, the file has the wrong
extension and you will have to rename it.

12. Make sure the current file path of IB_CLIENT_xxxx.mdf, where xxxx equals the
renamed file from step 2, is pointing to the correct location. If it is not, you will have to
change it.

13. Change the Attach as: file name to the file name you assigned in step 2.
14. After you have made your edits, click OK.

15. If the database was attached successfully, it will be displayed in the database folder. If
not, please correct any errors and try again.
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Do the same for the IBRM_xxxx and IBSR databases depending on your installation type.
Once the databases are attached to the SQL Server, you will need to create or assign a SQL
Server user account for the application. This user will be used for the connection to the
databases when setting up the connections from the Insbridge Framework Administrator.

If backups are to be allowed from the RateManager application (see page 36 for more details),
then the ibru SQL server user account must have the Disk Administrators SQL Server role.

For ease of administration, the database user should have db_owner permissions on the
IBRM_xxxx , IB_CLIENT, and IBSR database. See page 76 for further details on tightening user
permissions.

SoftRater Database Creation and Installation in Oracle

Oracle database files are packaged in the install. The file is located in the
Databases>» Oracle > SoftRater folder. The file name is usp_IBSSR_v03.12.0.oracle.

Please see Oracle Database Setup and Update Instructions for further instructions.

It is strongly recommended that any database modification be performed by a
qualified database administrator (DBA). The database setup procedures and
tasks require the skill set of a database administrator. If you are not a
database administrator, please stop. Improper setup may result in unwelcome
changes to the database. Please consult with a qualified database
administrator before proceeding.

IMPORTANT]
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Configuring Insbridge Framework Administrator

Open an Internet Explorer web browser either remotely on the local IBRU web server and
browse to the following location, replacing SERVERNAME with the actual server name:

http://SERVERNAME/ibfa/

ﬁ' Framework Administrator (PLOADOCO1) - Windows Internet Explorer E‘E‘E|
@— = €] http:/00.100.0.00/1EFa) ~l 4] X 2

Fle Edb View Favoriies Tools  Help

T & | @ Framemork Admiristrator (PLOADOCOL) | B - 6 @ e - Gk T

Framework administrator - Version 2.3.2 1l INSBRIDGE

%
=] ﬂ Configuration File [C:'\PROGRAM FILES'ORACLE'IGBU' INSBRIDGE' FRAMEWORK"2.0.0' Insbridge.Xml
3 seftRet The Framework Administratar wreb wil configure any Insbridge Framewark, Canfiguration File {Insbridge. ) Found on your
ortRater network, Although all Insbridge Applications may have their own wersion of this configuration fils, we suggest that all apps
3 softData that reside on the same Framework Server share the same: file
| Services 7
Ie| H . Update
3 togs Change Canfig File location Browse, p

[ Security
a8 softlibraries
©) Help

Add Subscribes

Please consult wifl an Insbridge sales or suppart represertetive before addingfediting subscriber information.

# Mo Subscribers found,

Add Database Connection

Create or edit database connection. This database connection can be global ta the Insbridge Framework or unique to the
Subscriber.

[Click on the name of the connection to edit.
£2 Global

# Mo Connections found,

Copyright @ 2000,2009, Oracle and/or its affilistes. Al rights reserved

Figure 32 IBFA Home

N[@IR=N Please refer to the IBFA guide for managing and editing IBFA components.

1. Click on Add Subscriber and in the next dialog.

The Type, ID and Name information for the new subscriber is chosen by you. The Type, ID and

Name are fixed after the first time you save. These entries cannot be edited. Only the description
can be edited.

NOTE If you have more than one instance of IBFA, it is strongly suggested that you create
the identical Subscriber, Type, ID and Name in every instance.
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http://servername/ibfa/

The Subscriber ID can be a 3 or 4 digit number and must unique for each subscriber per instance
of IBFA. For example, if you have an instance of IBFA on machine A, you can create a subscriber
with an ID of 100. On machine A, if you create another subscriber, you must give that subscriber
a different ID number, say 200. If you also have an instance of IBFA on a different machine, B for
example, you should duplicate the same subscribers with the same ID numbers on machine B.

If you require assistance or are unsure of what action to take, please log a Service Request using
My Oracle Support at http://metalink.oracle.com.

23 Subscriber -- Web Page Dialog

Subscriber
Please enterfupdate vour Insbridge Customer information below,

Twpe: | Carrier b
i[BH 100z
MName: Mary

Desc:  MARY RM|

Save Cancel

Figure 33 Enter ID

Next select the Add Database Connection link. The three databases must be added to IBFA:

e Subscriber: Global with Name: controller
e Subscriber: (Your Subscriber Name) with Name: security
e Subscriber: (Your Subscriber Name) with Name: RM

o If you are using a SQL Server SoftRater database, you can add and configure the
SoftRater database through IBFA. If you are using another database platform, Oracle for
example, you will need to configure the SoftRater database there.

The setups are similar for all three databases. The description information following the first
example will be the same for the other two databases.

In the next popup dialog, fill out connection information for the IB_CLIENT database using the
Global subscriber.

\[@RR=N If you have renamed the databases, please make note of the new names.
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2 Connection -- Webpage Dialog

Connection
Database connections can be global to the Insbridge Framewaork ar unique to the Subscriber.

Subscriber; Global W
MName: contraoller
Server: LOCALHOST Test Connection...

Server Type: | SQLServer W

Catalog: IB_CLIENT MARY
Catalog Type: | Other b
Query Buffer:

Tablespace:

Schema:

Lser: 53

Pazsword: LI

Save Cancel

Figure 34 Setting up the Global Database Connection

Select Global for the Subscriber. The IB_CLIENT database is a global database and is not
unique to the subscriber. This information cannot be changed once you have saved it.

The Database Name cannot be changed once you have saved it.

The Server is the database server name or IP address which ever is resolvable by the IBRU web
server. You also can test the connection and make sure it is valid at the time of entry.

The DB Server Type is the type of server that houses the database. Currently, RateManager and
SoftRater support SQL Server, Oracle and DB2.

The Catalog is the name of the catalog in the database. For DB2 servers, this is the System DSN
Name.

The Catalog Type is the type of catalog in the database. The types available are: RateManager,
SoftRater and Other. If you are using a SQL Server, you can choose either RateManager or
SoftRater. If you are using an Oracle or DB2 database, you will need to choose Other and enter
the remaining information.
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Tablespace and Schema are not required for this connection. The User is the SQL Server user
(ibru) assigned as database owner on page Error! Bookmark not defined., if needed.

Add the next database. Select the Add Database Connection link again.

In the next popup dialog, fill out connection information for the IB_CLIENT database using your
subscriber ID. Name this one security.

2 Connection -- Webpage Dialog

Connection
Database connections can be global to the Insbridge Framewaork ar unique to the Subscriber.,

Subscriber: | MaryRM w
MName: security
Server; LOCALHOST Test Connection...

Server Type: | SQLServer e |

Catalog: IB_CLIENT_MARY
Catalog Type: | Other W |
Query Buffer:

Tablespace:

Schema:

Lser: sa

Password: LI

Save Cancel

Figure 35 Setting up the Security Database Connection
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If performing just a SoftRater node installation, then this next step can be skipped.

Create a connection for RateManager using your subscriber id. Name this one rm.

The Catalog Type must be set to RateManager when you are creating the
Connection from RateManager. If you leave it set to Other, you will receive an error.

A Connection -- Webpage Dialog @

NOTE

Connection
Database connections can be global to the Insbridge Framework or unigue to the Subscriber.

Subscriber: MaryRM L
MName: rm
Server: LOCALHOST Test Connection...

Server Type: | SOLServer b |

Cataloq: IERM_MARY
Catalog Type: |EETENENE"SE ~ |
Query Buffer:

Tablespace:

Schema:

User: 53

Password: T

Save Cancel

Figure 36 Setting up the RateManager Database Connection
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Next, create a default rating environment for the RateManager system.

Browse to SoftRater>»Explorer>»Subscriber name.

This default environment is not required if performing a SoftRater node installation.
Other environments will still need to be created to load SRPs to the IBSR databases.

More details are provided in the online help on how to set up your SoftRater
environments.

(= Framework Administrator (PLOADOCO1) - Windows Internet Explorer

@\ﬂ/ ~ [i2] hetpigjon.100.0.00fbFef

4 x| I

fle Edt  Vew Favortes Tooks  Help

= — = »
w oA [@Framewurk Administrator (PLOADOCO1) ] I -8 f=h ~ =k Pags - () Tooks ~

Framework Administrator - Version 2.3.2 il INSBRIDGE

[x]
Config
£ 3 Insbridge

= [ SoftRater

[ Engine
= 3 explorer Explorer Add Environment
MARY Add, edit, or remove enslonments from your Explorer configuration.
ARY
[ SoftData
[ services
3 Logs # Mo environments found,
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Figure 37 Create a Rating Environment

Click on Add Environment.
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Environments -- Web Page Dialog

A SoftRater configuration can support an unlimited number of
environments,

Mame: M _Default

Twpe: | D o

Secure: [

Save Delete | | Cancel

Figure 38 Entering Name and Environment

The name and type are totally dependent on how your particular environment is designed.
There are three types of Environments:

e Development
e Quality Assurance
e Production

After you have entered your environment, you must define it.

Defining the Environment

Select your company name underneath Config on the left hand side to see the configuration for
the new environment created.

Frameweork Administrator - Wersion 2.3.2

]
Config
= [ Insbridge
Bl [ SoftRater
[ Engine
= [ Explorer Explorer Add Environment
MARY Add, edit, or remove environments Fram vour Explarer configuration.

[ SoftData AME - DESCRIPTION

L3 services @ RM Default - Development
[ Logs @ QA - Quality Assurance
[ Security @ Production - Production

Figure 39 Obtaining Environment Information
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Figure 40 Editing Environment

Enter in the DB_SERVER name with the real name of the SQL Server where the IBRM database
resides.

Only the information shown above is required for this connection; Environment, DB Server, DB
Server Type, DB Catalog, DB Catalog Type, DB User, DB Password, Engine Type and Engine
Location. The Package Location, DB Query Buffer, DB Tablespace, DB Schema, and Engine
EnvDef can remain blank or filled out as needed. The user account should be the database
owner (ibru).

For each environment, you can set up the following information:

Environment: The name of the environment. Selecting the radio button next to an
environment's name will set it up as the default environment.

Package Location: Physical location of where the packages should be stored. Click

Options... | to run a process to validate the permissions on the directory and certify any
packages in the directory. In order for the Framework Administrator to successfully
manipulate packages in the location, it must have full control of the directory.

DB Server: The name of the server that houses the database that packages will be
loaded to.

DB Server Type: The type of server that houses the database. Currently, RateManager
and SoftRater support SQL Server, Oracle and DB2.
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DB Catalog: The name of the catalog in the database.

DB Catalog Type: The type of catalog in the database. The types available are:
RateManager, SoftRater and Other. If you are using a SQL Server, you can choose
either RateManager or SoftRater.

*DB Query Buffer: For certain Database Management Systems (DBMS), system batch
query optimization is required for performance and/or because of limits on/in the system.
This value will control the maximum number of batch query operations that can be
submitted to the target DBMS in any one transaction. It is known that for certain DB2
platform versions a value of 31 is required because of a hard software limit.

*DB Tablespace: The name of the table space in the database.

*DB Schema: The name of the schema that defines the structure of the database.

DB User: Username to access the database.

DB Password: Password to access the database.

Engine Type: The type of SoftRater engine that is used. The available options are:
SoftRater for Windows, SoftRater for WebSphere, SoftRater for WebLogic, or SoftRater
for JBoss.

Engine Location: The location of the SoftRater engine. If the engine is local to the
Framework Administrator (i.e. located on the same server), leave this field as
LOCALHOST. If the engine is located on a different server, enter the name in the box.
Engine EnvDef: This field should remain blank, unless the engine is located on a
different server. If the Engine Location is set to LOCALHOST, leave this field blank. If

the Engine Location is not LOCALHOST, this should match the name of the
environment on the remote server.

If you are using an Oracle or DB2 server, the options and requirement will be
N[O =W different. Please see the Insbridge IBFA User Manual (Located in the User Guides
directory) for more information.

Updating the Component Services

Next, you will need to update the component services.
1. Click Start»Programs>»Administrative Tools»Component Services.
2. Expand the Component Services option under console Root.
3. Expand Computers>»My Computer>»COM+ Applications.

4. Expand each Insbridge COM+ library to make sure there are components listed
underneath each compartment.
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Figure 41 Component Services

There should be 3 Insbridge Com+ Applications libraries:

e Insbridge Com+ Administrator 2.0
o Insbridge Com+ SoftRater Engine
e Insbridge Com+ SoftRater Library

Please note that you will not have to make any changes to any COM+ Application library. The
installation will automatically apply the Insbridge user name and password that you created
earlier to the necessary libraries. If you change the password, you will have to change the
password in all three of the Insbridge Com+ libraries. On each library, right click, select
Properties, select the Identity tab, enter in the new password.

If any COM+ library is missing, run the IBRU install again from the msi file and
choose uninstall. Then rerun the IBFA install. Uncheck the RateManager Install.
Then check again to see if all the libraries are listed. If they are still not listed, please
log a Service Request using My Oracle Support at http://metalink.oracle.com.

NOTE
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Export Insbridge Registry Key for Backup

If performing just a SoftRater node installation, this step can be skipped.

The Insbridge registry key located in HKEY_LOCAL_MACHINE»SOFTWARE > Insbridge is used
to store all information for proper encryption of the SoftRater Packages (SRPs). This registry key
should be exported using regedit to a text file and stored in a safe location off the server and/or
sent to Insbridge in the event of a catastrophic server failure and the IBRU system needs to be
reinstalled.

Export and Import Subscriber Registry Key for SoftRater Node
Installation

If performing a SoftRater Node installation, then the encryption stored in the registry key
on the server where the RateManager application resides will need to be exported and
then imported on the SoftRater Node.

1. On the server where RateManager is installed, open regedit, then navigate to the
HKEY_LOCAL_MACHINE>» SOFTWARE > Insbridge > Subscribers» SUBSCRIBER_NAM
E where SUBSCRIBER _NAME equals the name as entered on page 36 and given to you
by Insbridge.

2. Select the Registry menu option and select export.

£ Registry Editor
ZI°W Edit Yiew Faworites Help

MNarne

b]Def
i_l_ﬂCapi
i_bﬂCapi
] %50

Connect Metwork Regiskey, ..

Print... Chr+P
Exit

[ Gemplus

i e

=7 Insbridge

[ 200
=27 Subscribers

[ 1om
== MARY |

Figure 42 SoftRater Node Installation
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3. Enter the key file name and save this to the desktop.
4. Copy this file to the SoftRater Node on the receiving IBFA.

5. Double-click this file. You will be asked if you wish to continue to import this data into the
registry. Select Yes.

6. If the import was successful, then you will receive a report that it was successfully
installed. If the import fails, please correct the error and try again.

Now the encryption on the RateManager server where the SRPs are created and the SoftRater
Node where the SRPs are loaded match.
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4

Installing the OBI Publisher

OBI Publisher is necessary for reports. If you do not plan on using reports in RateManager, you
do not need to install this program.

This step can be skipped for a SoftRater Node install only.

1. Unzip the OBI_PUBLISHER

# OBI Publisher Setup EE
0Bl Publizher "
Release Mokes, (47

Install l [ Cancel

Figure 43 Installing OBI Publisher

2. Click Install. A progress screen will be displayed.
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# OBI Publisher Setup =

Installation Complete (—

)

Setup was completed successFully,

Completed

Shiow details

Cancel

3. When complete, click Close.

4. In order for OBI Publisher to be available to users, you must start the Insbridge Message
Service. In IBFA, navigate to the Services page.

Insbhridge Message Service Stop

The Insbridge Message Service is a Message Queue Listener that will rouke all batched messages ko an assembly (process)
for execution. These processes may take resources and time to execute, Please consult with vou systern admin before
configuring the number of listeners per process,

essage Process

| Batch Rating w | Wiew Messages Edit Process Configuration

If you see this message, vou have not requested a listing from the selected spoke client, Clicking
Yiew Messages will provide you with a list wiew of the first in - first out messages that are waiting to
execute,

Insbridge Task Manager |3Stark
The Insbridge Task Manager gives wou the ability to execute daily, weekly, hourly, or by the minute.

Yiew Tasks | (This process may bake a while to execute)

TASK LAST RUN-DATE START-TIME STATUS

Figure 44 Insbridge Services Screen

5. Next to Insbridge Message Service, click | =2t | After a few seconds, the buttons will refresh
to indicate that the service is started.
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Updates to the Insbridge Application

An update to the system can be run from the same installer. Unzip the IBRU folder on the

machine where the IBRU system (IBFA and RateManager) is currently installed. Click the
installer.

During the installation, the installation program requires the installer have administrator rights on
the machine where the install is occurring. Please close all open applications and run the Oracle
Insurance — Insbridge Rating and Underwriting file.

A Welcome screen will be displayed.

i Oracle Insurance - Insbridge Rating and Undemwriting 3.12.0/5... E||E|E|

4 Oracle Insurance Insbridge Rating and Underwriting

[t iz strongly recommended that you exit all Windows programs befare running this setup program.

Click Cancel to quit the getup pragram, then cloze any programs pou bhave running. Click Hest to
continue the installation,

WARMIMG: Thiz program iz protected by coperight lavw and international treaties.

Ilnauthorized reproduction or distriibution of this program, or any portion of it, may result in severe civil
and criminal penakties, and will be prozecuted ta the masimurn extent pozsible under law.

ORACLE

INSURANCE

mEHU i [ Cancel

Figure 45 Installing Insbridge

1. Click on Next to continue.
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2. The next screen is the Logon Information screen. Please use the Insbridge user account
information that you set up earlier.

i& Oracle Insurance - Insbridge Rating and Underwriting 3.12.0 5... E_||E|E|

Logon Information DRACLE‘

The following logon information is uzed by Insbridge. INSURANCE

Specify a uger account to be uzed by the application, either for running a service or for
logging onto other servers. Uze the Browse button to chooze wuzers from pour network:.
For domaing, user names must be in the format of DORAIMNS zerM ame.

Pazsword:

EEREEETY

[ Create Mew zer...

YWize Installation ‘Wizard [R]

< Back " Mest » ] [ Cancel

Figure 46 Entering User Information for Insbridge

3. Click Next to continue.
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4. The next screen will list the applications to be installed. To expand the options and view
details, click on the downward arrow. All features are checked for installation. RateManager
is the only one that you will be allowed to not install.

i Oracle Insurance - Insbridge Rating and Underwriting 3.12.0 5... E||E|E|

Select Features DRACLE

Fleaze select which features pou would ke to install

INSURANCE

Feature Description:

Oracle Insurance Inzbridge A ating and
Undenanting iz a*Web-based rating, rules, and
= vI Oracle Bl Publizker undenariting zpetem.

Thiz feature will be installed on the local hard
drive.

Thiz feature requires OKB on pour hard drive. [t
haz 2 of 2 subfeatures zelected. The subfeat.

Current location:
C:A\PROGRAK FILESSORACLEMGEUMMSERIDGEY

Wize [nztallation Wizard [R]
[Qisk Cost ] [ Bezet ] [ ¢ Back " Mest = ] [ Carnicel

5. Click Next to continue.
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i Oracle Insurance - Insbridge Rating and Underwriting 3.12.0 S... |Z||E|[z|
Ready to Install the Application ORACLE’

Click. Mest to beqin installation. INSURANCE

Click the Back button to reenter the ingtallation infarmation or click Cancel to exit
the wizard.

Wize Inztallation ‘Wizard [R]

g [ Cancel

6. A Ready to Install screen will be displayed. If you are ready, click Next. Otherwise click Back
to check the options you want to install. A progress screen will display your progress.

i Oracle Insurance - Insbridge Rating and Undemwriting 3.12.008, .. |;||E|fz|
Updating System ORACLE

The features you selected are curently being inztalled.

INSURANCE

Yalidating install...

YWize Inztallation Wizard [R]

Cancel
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7. When complete, a ReadMe Information screen will be displayed.

i Oracle Insurance - Insbridge Rating and Undemwriting 3.12.008, .. E||E|E|

Readme Information DRACLE

Insbridge haz been succezsfully installed.

INSURANCE

Microsoft Windows 20002003 Server ~
A full installation of Microsoft Windows 2000 (either Server or Advanced Server)

or Microsoft Server 2003 is required. The following configuration assumes that

the administrator of the server to be generally familiar with managing a YWindows
server.

Components of Windows 20002003 Server

All Windows Server components are available for installation from the Control
Fanel, Add/Remove Programs applet by selecting Add/Remove Windows
Components. In order to install these YWindows Components, you may be
required to have the Windows Installation COROM available,

Internet Information Services (lIS)
The In=Bridge Rating and Underwriting Systerm is a web based application and  »

YWize Inztallation Wizard®
| <Back | Firish | | Cancel

8. Click Finish.

N[OFN= Any Insbridge services will be stopped during the update.
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Database Updates

Database updates can be performed in RateManager for the RM and IB_Client databases. This is
the recommended way to update these databases. The SoftRater database will need to be
updated on the machine where it is located.

To update the RM and IB_Client databases, log into RateManager.

Working with RateManager for the First Time

The URL for RateManager will be http://INSTALLATIONSERVERNAME/RM. Where Installation
server is the server where RateManager was installed.

This will place you on the RateManager login screen.
1. Tologin for the first time, select your company from the drop down menu.
2. The user name will be demo.
3. The password will be password.

To change your password, go to Administration>»Change Password.

For more on user management, please see the RateManager User Guide.

NOTE If you log into RateManager and Tools is the only option, you must perform a
database update.

If you are having difficulties logging into RateManager, please check the error logs in
NOTE gy

Running Database Updates in RateManager

Database updates can be done on the IB_CLIENT database and the IBRM database. SoftRater
database updates must be performed on the machine where the SoftRater database is located.
No SoftRater updates are required for a new installation.

If you log into RateManager and Tools is the only option, you must perform a database update.
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http://installationservername/RM

On the Updates screen, the current version will be highlighted and the status will be Current. The
updates below the current version will be grayed out. These updates cannot be run again. You
will receive an error message if you attempt to run a lower version update. Any version update
above the current version will also be grayed out but will be available for executing.

Updates have to be installed sequentially, meaning if you are on Version 3.9, you must run the
3.10 update, then the 3.11 update and finally the 3.12 update. If you attempt to run an update that
is more than one level above the current version, you will receive an error message.

1. Navigate to the Backups tab.

2. Click the Updates tab. Select the database you want to view from the Show updates for
drop down. The database updates will be listed. The last column, the Status column, will
show you which update is the Current one installed.

/ Backups ]/ Updates 1

Refresh Listing sy Execute Update Script Open Update Script 5] Save to File

Show updates for: | IETININGEG_—_—_—_—
e === =
v03.12.0.00 4/30/2009 IBRM
u[:-z 11.0.00 11/30/2008 IBRM Current
v03.10. 8/31/2008 IBRM
5,/19/2008 IBRM
6/7/2007 IBRM
7/6/2006 IBRM

Figure 47 Available Updates

3. There are two ways to execute an update:

a. Directly in RateManager: This is recommended way to update a database.

i. Highlight the update you want to run. Begin with the lowest update. For
example, if you are going from version 3.9, you must run the version 3.10
update first. Click ks Execute Update Script A warning message will be
displayed.

ii. Click OK to run the update or Cancel to return to the previous screen.

iii. Do this for both the IBRM database and the IB_CLIENT database.

b. Use Query Analyzer: This method should be performed by a database
administrator. No warning message will be displayed if you execute scripts in the
wrong order. You must know the name of the databases you are updating.
Please see Manual Updates to the IBRU Database.
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Oracle Database Setup and Update Instructions

Oracle database files are packaged in the install. The IBSR_TEMPLATE file is located in the
Databases>» Oracle > SoftRater folder. The file name is usp_IBSSR_v03.12.0.oracle.

It is strongly recommended that any database modification be performed by a
qualified database administrator (DBA). The database setup procedures and

tasks require the skill set of a database administrator. If you are not a
IMPORTANT database administrator, please stop. Improper setup may result in unwelcome
changes to the database. Please consult with a qualified database
administrator before proceeding.

These instructions are high level and require that the setup person be a DBA.

1. You will need to create the database. Oracle Insurance does not have specific
requirements, whatever requirements are deemed necessary by your company’s internal
standards will work. It is recommended that you included the version number or
environment name if you are planning on creating more than one instance.

a) Create default tablespace for the Soft Rater database.

b) Create user IBSR & assign basic connect & resource grants.

This is next section is for information only. No action needs to be performed unless a new
table needs to be created.

If a database table needs to be added in the SoftRater for Oracle at installation or any time later,
the DDLs are located in the IBFA Installation Directory under the SoftRater/DDL folder. l.e.
[INSTALL_DIR}/Insbridge/SoftRater/DDL.

Have this information ready:

The LOBs that your company uses. You will need the ID number for each LOB.
Your customer number.

Location of the Insbridge files.

Insbridge ODBC document.

Insbridge IBFA Guide.

Insbridge IBSS Guide.
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1. Create the tables.

o If a database table needs to be added, the DDLs are located in the IBFA
Installation Directory under the SoftRater/DDL folder. I.e.
[INSTALL_DIR]/Insbridge/SoftRater/DDL.

e You will have to replace the TABLESPACE name in the scripts with the
tablespace name you used when you created the database.

¢ On the DT tables, you will need to create one for every LOB. An example of the
format is in the comments of the script. It requires the LOB ID number and the
customer number.

2. Run the client. Use the ODBC document.

3. Create the database connections to IBFA. These instructions start on page 17 of the
IBFA Guide. This is assuming that a subscriber is already in place.

4. Create and configure an environment in IBFA. These instructions start on page 35 of
the IBFA Guide. Or if you have the environment setup already, you would only need to
configure it. Be sure to test the environment.

5. A final test would be for a user to create a full package in RateManager. Make sure the
environment you used for your new database is displayed in the drop down and the SRP
is loaded.

6. If you are rating in WebSphere, WebLogic or JBoss using IBSS, you will need to create
and configure an environment in IBSS. These instructions start on page 14 of the
IBSS Guide. Be sure to test the environment.

NOTE If you cannot locate the DDL files or the [INSTALL_DIR]/Insbridge/SoftRater/DDL
file, please contact Support for further assistance.

Location of DDL Directory

If a database table needs to be added in SoftRater for Oracle or SoftRater for DB2, the DDLs are
located in the IBFA Installation Directory under the SoftRater/DDL folder. l.e.
[INSTALL_DIR]/Insbridge/SoftRater/DDL. This information may be needed if you are attempting
to add an LOB and receive missing table errors. Creating tables in Oracle or DB2 should be
performed by a qualified DBA.
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Manual Updates to the IBRU Databases

When running an update, you may be required to update the database. In the RateManager,
Security, and SoftRater Database folders you will find the current database scripts. The
RateManager and Security database update script will take previous IBRM and IB_CLIENT
databases from version 3.11 to version 3.12 only. To go from alower version up to 3.12, you
must enter RateManager.

The IBSR database update will need to be run once, regardless of version, in the corresponding
database.

Oracle database updates must be performed directly on the Oracle database by an
IN[@J=8 Oracle DBA. Improper scripts updates can result in database failures. Oracle
database updates are not available on RateManager.

To Perform Database Updates from RateManager

The preferred method of updating the IBRM and IB_CLIENT databases is to go into
RateManager. If the administrator has DB User privileges and is the DB Owner of the database
as well as the disk administrator, database updates can be done on the
Tools>»DataBase»Updates screen. If these privileges are not in place, an error message will be
displayed. See Running Database Updates in RateManager for instructions.

If you need to go from a lesser version, such as 3.9, you will have to enter
IN[@3F=H] RateManager and run the 3.10, 3.11 and 3.12 update scripts successively from
there.

Manual Database Updates

Database updates are available in RateManager on the Tools > DataBase > Updates screen. To
manually update a SQL Server database, you will be required to save off each update and run
them in sequential order in SQL Server.

1. In RateManager, highlight the update you want to run. If you are going from a much lower
version of RateManager, you may have to save multiple files for each database.

2. Click 4 Saveto FilE your computers dialogue box will be displayed. Save the file to a
location of your choice. For IBRM scripts, it is recommended that you rename the file to
usp_IBRM_RO(version number).sql. For example the V3.10 update would be:
usp_IBRM_R0310.00.sql. For IB_CLIENT scripts, it is recommended that you rename the
file to usp_IB_CLIENT_RO(version number).sqgl. For example the V3.10 update would be:
usp_IB_CLIENT_R0310.00.sql.

3. Open Query Analyzer in SQL Server.
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4. To view the update script prior to execution, highlight the update you want to view. Click
Open Update Script. The update script will be displayed in a separate screen.

3 1BRU : v03.12.0.00 -- Webpage Dialog

Dclose

TO =

if exists (select * from dbo.sysobjects where id = object_id(N' [dbo].[IDNX_NOTES]')

and OBJECTPROPERTY (id, N'IsUserTable') = 1)
drop table [dbo].[IDNX_NOTES]
co

CREATE TABLE [dbo].[IDNX_NOTES] (
[ID] [numerie] (18, 0) IDENTITY(1,1) NOT NULL,
[APPLICATION] [int] NULL,
[APPUSER] [nvarchar] (50) COLLATE SQL Latinl_General CP1_CI_AS NULL,
[DATE] [datetime] NOT NULL,
[NOTETYPE] [int] NOT NULL,
[TAGID] [mvarchar] (20) COLLATE SQL Latinl General CP1 CI &S NULL,
[DESCRIPTION] [mvarchar] (200) COLLATE SQL_Latinl_General CP1_CI_AS NULL,
[DATA] [image] NULL,
[DT1] 1(50) COLLATE SQL Latinl General CP1_CI &S NULL,
[DT2] 1(50) COLLATE SQL_Latinl_General CPl_CI_AS NULL,

[DT3] 1(50) COLLATE SQL_Latinl Genmeral CP1_CI_AS NULL,
[DT4] 1(50) COLLATE SQL Latinl General CP1 CI &S NULL,
[DTS] 1(50) COLLATE SQL Latinl_General CP1_CI_AS NULL,
[DT&] 1(50) COLLATE SQL Latinl General CP1 CI &S NULL,
o 1(50) COLLATE SQL_Latinl_General CPl_CI_AS NULL,
D 1(50) COLLATE SQL_Latinl General CP1_CI_AS NULL,

[DTS] 1(50) COLLATE SQL Latinl General CP1 CI AS NULL,
[DT10] [nwarchar] (50) COLLATE SQL Latinl General CP1_CI_AS NULL
) ON [PRIMARY]
GO

ALTER TABLE [dbo].[IDNX NCTES] WITH NOCHECK ADD
CONSTRAINT [PK_IDNX NOTES] PRIMARY KEY CLUSTERED
(
[ID] ASC
} CON [PRIMARY]
GO

INSERT ITEM STATUS
(STATUS_ID, STATUS_DESC, STATUS_DATE, ITEM_TYPE,ITEM SCHEMA ID,ITEM KEY,
[USER_ID],USER FULLNAME,USER SES5ION) VALUES (1,'CHECKED IN','01/01/1996",'SYSTEM',- v

Figure 48 Script Viewer

For SQL 2000:

The DBA or a person with the proper permissions will need to apply the database update using
Query Analyzer to the database listed in the SQL script name. For example:
usp_IBRM_v03.12.xx.sql is applied to the IBRM database whereas usp_IBSR v03.12.xx.sql
would be applied to your IBSR_ database.

If you prefer to manually update your databases, you can use this method to update the IBRM
and IB_CLIENT databases. You must use this method to update the IBSR database.

If you do not have database permissions, you will not be able to perform the following
database queries.

If you are unsure how to work with databases, please consult with your database
administrator.

When using Query Analyzer, the SQL scripts must run on each individual database
as shown below.

NOTE

1. Open up the DB script updates that you downloaded in RateManager. You can open in
any program you want, such as Notepad. Begin with the next sequential update. For
example, if you are going from V3.9 to 3.12, open 3.10 first.
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Figure 49 Updating Database

2. Select the database you want from the drop down menu. In SQL Server, create a new
query with Query Analyzer.

3. The query screen will be displayed.
4. Copy the first update from Notepad and paste onto the query screen.

5. Click Execute. The script will execute. Any messages will be displayed in the lower
portion of the screen. You must run the updates in sequential order. Run each update
until you run the 3.12 update. Then continue on to the next database.

The IBSR database update for 3.12 is the only update that will need to be run for the

NOTE SoftRater database.

6. For example, if you want to update the IBRM database in SQL Server, select the IBRM _
database from the drop down menu. In SQL Server, create a new query with Query
Analyzer.

7. The query screen will be displayed.

8. Copy the first update from Notepad and paste onto the query screen.

9. Click Execute. The script will execute. Any messages will be displayed in the lower
portion of the screen. Run each update until you run the 3.12 update. Then continue on
to the next database.

10. If you want to update the IB_CLIENT database in SQL Server, select the IB_CLIENT
database from the drop down menu. In SQL Server, create a new query with Query
Analyzer.

11. The query screen will be displayed.
12. Copy the first update from Notepad and paste onto the query screen.
13. Click Execute. The script will execute. Any messages will be displayed in the lower

portion of the screen. Run each update until you run the 3.12 update. Then continue on
to the next database.

14. After the scripts have been run, return to RateManager. Click Refresh Listing. The
status should show current and the full RateManager menu should be displayed.

The updates are now properly applied and users can log back in to the system.

NO warning messages will be displayed if you run updates in SQL Server in
IN[@JR=N] the wrong order. Running updates in the wrong order can cause irreparable
damage to your database.
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For SQL 2005:

The DBA or a person with the proper permissions will need to apply the database update using
Query Analyzer to the database listed in the SQL script name. For example:
usp_IBRM_v03.12.xx.sql is applied to the IBRM database whereas usp_IBSR_v03.12.xx.sql
would be applied to your IBSR_ database.

You can use this method if you are updating the IBRM and IB_CLIENT databases from IBRU
3.11 to IBRU 3.12 only. You must use this method to update the IBSR database.

If you do not have database permissions, you will not be able to perform the following
database queries.

If you are unsure how to work with databases, please consult with your database
administrator.

NOTE When using Database Engine Query, the SQL scripts must run on each individual
database as shown below.

1. Open up the DB script updates from the download file. You can open in any program
you want, such as Notepad. Begin with the next sequential update. For example, if you
are going from V3.9 to 3.12, open 3.10 first.

B Microsoft SQL Server Management Studio

file | Edit  Yiew Tools ‘Window Community Help

¢ Connect Object Explarer... L‘E B ¥ et = | :‘J =l L; b{ i -
I 47 Disconnect Object Explorer

‘ Object Explorer Details |

[ hew v roject... Ctrshift+N

Open G Query with Current Connection  Ctrl+N

_MARY

Close: ‘
\TB_CLIEMT_MARY 3 Ttem(s)

Database Engine Query

‘Y Analysis Services DMK Query

Liy
@; Analysis Services MDX Query
3
et |

Y Analysis Services ¥MLA Query

@ saveal QSIS | % ol Server Compact Edtion Query
Source Control » L Views
L Synonyms

[ Progr anmmabilicy
[ Service Broker
Exit A Storage

L Security

[ T8RM_310_TEMPLATE

Figure 50 Updating Database

2. Select the database you want. In SQL Server Management Studio, create a new
Database Engine Query, File>New>»Database Engine Query.

3. The query screen will be displayed on the right hand side.

4. Copy the first update from Notepad and paste onto the query screen.

The IBSR database update for 3.12 is the only update that will need to be run for the
SoftRater database.

NOTE

5. Click Execute. The script will execute. Any messages will be displayed in the lower
portion of the screen. You must run the updates in sequential order. Run each update
until you run the 3.12 update. Then continue on to the next database.
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10.

11.

12.

13.

14.

For example, if you want to update the IBRM database in SQL Server, select the IBRM _
database. In SQL Server Management Studio, create a new Database Engine Query,
File»New>»Database Engine Query.

The query screen will be displayed on the right hand side.

Copy the first update from Notepad and paste onto the query screen.

Click Execute. The script will execute. Any messages will be displayed in the lower
portion of the screen. Run each update until you run the 3.12 update. Then continue on
to the next database.

For example, if you want to update the IB_CLIENT database in SQL Server, select the
IB_CLIENT database. In SQL Server Management Studio, create a new Database
Engine Query, File>»New>»Database Engine Query.

The query screen will be displayed on the right hand side.

Copy the first update from Notepad and paste onto the query screen.

Click Execute. The script will execute. Any messages will be displayed in the lower
portion of the screen. Run each update until you run the 3.12 update. Then continue on

to the next database.

After the scripts have been run, return to RateManager. Click Refresh Listing. The
status should show current and the full RateManager menu should be displayed

The updates are now properly applied and users can log back in to the system.

Updating the SoftRater Database from a Lower Version

For SQL Server Only: The only upgrade needed to perform for SoftRater is adding the new
stored procedures on all of the IBSR databases. This can be accomplished by opening Query
Analyzer and connecting to the IBSR database. Then run the included SQL script
usp_IBSR_v03.12.sql available in the install download. If the script is not included, then it has
been run.

For an Oracle Database: Run the corresponding Oracle file.
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8

Advanced Settings and Permission Notes

Advanced Settings for RateManager

If performing just a SoftRater node installation, this step can be skipped.

The RateManager application can be extended to suit many different types of distributed
environments. Most of this customization should be perform only with the help of an Insbridge
Application Engineer. To access these settings, open the RateManager application in a web
browser http://SERVERNAME/RM/ and at the login screen, press and hold the left Control and
Shift keys and then press S. This should bring up the following dialog:

Insbridge Configxml Path;
Messaging Server |

SoftRater Server

Backup Share Folder Location:

Use Insbridge Com+ Admin:
Enforce Release Packaging:

Batch Package Threads:

Minirmurn Login User 1D Length:

User must change password:
Show Orverride Dake Mask:
Allow Data Type Change:
Inactive Session Time Cut:
Batch Fesulks with Mewline:
Cnline Help Server:

hange Control:

pdate

|D:'I.F'HEII3RAM FILESMNSEBRIDGEVRAM EWDRK‘I.Z.EI.EI".Insbring

| (Secure Channel F

|I|:uca|h|:|5t

| (Secure Channel) ¥

|I|:uca|h|:|5t

|I::'I.Data|:|ases |

True W
Falze |»
{Da';.fsjl

Truae W

Trua W

(hrs)

Falze

[SOUTHERN

on W

Figure 51 Configuring Advanced Settings

By default these settings should be OK to start when deploying a standard RateManager
application. One item that can be configured is the location for the backup files. RateManager has
the ability, if the server administrator and database administrator agree to allow it, to perform a
database backup of the IBRM_xxxx database and then the zip it up to be sent to Oracle
Insurance Support.
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This means that business users of RateManager require the assistance of either the server
administrator or the database administrator in the event that Oracle Insurance Support requests a
database snapshot. This configuration is totally dependent on the corporate environment where
IBRU is installed and whether permissions will be granted to the business users to perform this
action. The default is turned off.

Permissions Required by the ASPNET Microsoft .NET User Account

These are the permissions required by the ASPNET local user account as set forth by Microsoft
in order for ASP.NET based applications to run properly.

Read / Write Access is required for:

e The %installroot%\ASP.NET Temporary Files directory. Subdirectories beneath this root
are used for dynamically compiled output. Usually located in
%WINDIR%\Microsoft. NET\Framework\v2.0.50727.

e %temp% directory, which is used by the compilers during dynamic compilation.

Read Access is required for:

e The application directory (e.g.: the location where you installed the Insbridge
applications).
o The %installroot% hierarchy to make it possible to access to system assemblies.

e The web site root directory (e.g.: the path at which the “Default Web Site” points, typically
Y% systemdrive%\inetpub\wwwroot.

e The Global Assembly Cache, %windir%\assembly.

Default SQL Server Database User Roles and Permissions Required

If a more granular approach is required for management of security of the IBRU databases, then
the following guidelines can be used to set the required permissions.

These are only guidelines. If not properly configured, certain processes within the
Insbridge Rating and Underwriting System will fail. An experienced database
administrator’s expertise is highly recommended before making any security
changes.

o« IBSR Database User — Account requires dbo access to the IBSR databases because it
creates new tables in the SoftRater (IBSR) database dynamically when or if a new line of
business SRP (SoftRater Package) is loaded to the SoftRater system.

e IBRM_xxxx and IB_CLIENT Database User — Account requires execute access against
the Insbridge stored procedures and full access to the Insbridge schema.
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Extended Permission Required by the Insbridge User

If the Insbridge user account will not have full administrative permissions on the server where the
Insbridge Framework is installed, then certain operations from the Insbridge Framework
Administrator will not be available.

In order to start the Insbridge services from IBFA, the Insbridge user must be given full access to
both the Insbridge Message Service and the Insbridge Task Manager Service. There are a
number of ways to perform this and more details can be obtained from Microsoft at
http://support.microsoft.com/?kbid=288129. This article describes several methods for granting
users the rights to manage services in Windows 2000 Server. By default in Windows 2000
Server, only Administrators and Power Users can start, stop, or pause services. This article
describes techniques for granting these rights to other users and groups.

The following is one of the methods outlined in the above-mentioned KB Article:

Click Start, click Run, and then type MMC.

On the Console menu, click Add/Remove Snap-in.

Click Add.

Select the Security Configuration and Analysis snap-in, and then click Add.
Click Close, and then click OK.

In the MMC, right click the Security Configuration and Analysis item, and then click
Open Database.

Give a name for the database, and then browse to where you would like to store it.

8. When prompted, select a Security Template to import. For example, the "basicwk.inf"
contains values for the standard settings found on a Windows 2000 Professional
computer.

9. Inthe MMC, right click the Security Configuration and Analysis item and then click the
Analyze Computer now option. Choose a location for the log file, when prompted.
10. After analysis is complete, configure the service permissions as follows:
a. Double-click the System Services branch in the MMC.
b. Right click the service that you want to change, and then click Security.
c. Click Edit Security.

d. Add user accounts as required, and configure the permissions for each account. By
default, the user will be granted "Start, stop and pause" permissions.
11. To apply the new settings to the local computer, simply right click the Security
Configuration and Analysis item, and then click the Configure Computer Now option.

o0k wh =

N
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9
Support

If you need assistance with an Oracle Insurance Insbridge Rating and Underwriting System
product, please log a Service Request using My Oracle Support at http://metalink.oracle.com.

Address any additional inquiries to:

Oracle Corporation

World Headquarters

500 Oracle Parkwa
Redwood Shores, CA 94065
U.S.A.

Worldwide Inquiries:
Phone: +1.650.506.7000
Fax: +1.650.506.7200
oracle.com
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